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This manual is for the Cascade 4-Point Force Distribution 
Tester.  Contents include trolley Installation and setup, 
measuring clamp force, display configuration, reviewing 
recorded data and  parts.

CAUTION – A statement preceded by CAUTION is 
information that should be acted upon to prevent  
machine damage.

IMPORTANT – A statement preceded by IMPORTANT is 
information that possesses special significance.

NOTE – A statement preceded by NOTE is information that 
is handy to know and may make the job easier.

Special Definitions
The statements shown appear throughout this manual 
where special emphasis is required.  Read all WARNINGS 
and CAUTIONS before proceeding with any work.  
Statements labeled IMPORTANT and NOTE are provided 
as additional information of special significance or to make 
the job easier.

WARNING – A statement preceded by  
WARNING is information that should be 
acted upon to prevent bodily injury.  A 
WARNING is always inside a ruled box.

AC2771.eps

WARNING: When operating the attachment 
and 4-Point Force Distribution Tester, verify 
that all personnel are clear of the 4-Point 
Force Distribution Tester prior to clamping 
on the spindles.IMPORTANT: For service, technical and software 

questions about the display, contact the service 
support department of Antibus Scales & Systems, Inc. 
(574) 233-3160 (U.S. only).  International countries should 
contact a local Rice Lake® Weighing Systems dealer.
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NSTALLATIONI
1 Verify that all parts and hardware are present

AC2932.eps

Guide

x 4

Spacer Bar

x 4

Pin

x 8

Capscrew, M10 x 20

x 8

Washer, M10

x 10

Vertical Bar

x 4

Spindle

x 8
Display

x 1
Display Bracket

x 1

Hook and Loop Kit
(Cut to length hook 
and loop roll and 

10 buckles)

Small Tie Set
(10 ties)

Mounting Plate

x 1

Printer

x 1
Printer Bracket

x 1

Capscrew, M10 x 40

x 2

Lockwasher, M6

x 4

Capscrew, M6 x 20

x 4

Capscrew, M6 x 20

x 2

Capscrew, M3 x 12

x 2

Lockwasher, M6

x 2

Lockwasher, M3

x 2

Washer, M6

x 2

Washer, M8

x 16

Washer, M6

x 4
Nut, M8

x 16

Capscrew, M8 x 25

x 16

Caster

x 4

Back Support

x 4
Front Upper Support

x 2

Sliding Support 
with Spacer Bar

x 2
Sliding Support

x 2

Front Lower Support

x 2

Printer Option, if equipped
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2 3Assemble the sliding support, 
two sets

Assemble back supports with 
spacer bar, two sets

Sliding Support with 
Spacer Bar

Sliding 
Support

Back Support

Spacer Bar

Washer, M10 (two required 
for each set)

Capscrew, M10 x 20 
(two required for each set)

4 Install a guide to each back support flange.  
Face the guide's slide bar side inward.

Nut, M8
(two required 
on each side)

Back Support

Guide

Face slide 
bars inward

Washer, M8
(two required 
on each side)

Capscrew, M8 x 25 
(two required on 
each side)

Sliding 
Support

Face slide 
bars inward Back 

Support 
Flange

Guide

Upper Back Support

Lower Back Support

AC2933.eps
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NSTALLATIONI
5 Install sliding support assembly onto each 

back support/guide assembly

Note guide/support 
assembly orientation

6 Assemble the front upper supports 
with spacer bar

AC2937.eps

Upper Front 
Support

Spacer Bar

Washer, M10 (two required)

Capscrew, M10 x 20
(two required)

AC2938.eps

7 Assemble the front lower supports 
with spacer bar

Lower Front 
Support

Spacer Bar

Washer, M10 (two required)

Capscrew, M10 x 20
(two required)

AC2936.eps

Back Upper Back Lower
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8

9

Install back upper support/guide assembly to the 
front upper support assembly

Install back lower support/guide assembly to the 
front lower support assembly

Nut, M8
(two required 
on each side)

Front Upper 
Support 
Assembly

Front Lower 
Support 
Assembly

Back Upper 
Support/Guide 
Assembly

Back Lower 
Support/Guide 
Assembly

Nut, M8
(two required 
on each side)

Washer, M8
(two required 
on each side)

Washer, M8
(two required 
on each side)

Capscrew,
M8 x 25
(two required 
on each side)

Capscrew,
M8 x 25
(two required 
on each side)

AC2939.eps
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10 Install vertical bars into the lower support/guide 
assembly.  Install the detent pin into each support.
NOTE: The verticals bars require the same orientation.

11 Install the upper support/guide 
assembly onto the upper portion 
of the vertical bars.  Install the 
detent into each support

Position 
the vertical 
bars with 
the double 
hole set 
downward

Align with third 
lowest hole

Lower 
Support/Guide 
Assembly

Upper 
Support/Guide 
Assembly

Vertical Bar

Vertical Bar

Align with the 
first hole

Detent Pin

Detent Pin
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12 Install the mounting plate on 
top of the back vertical bar

AC2945.eps

13 Install the castor wheels to 
the vertical bars

Capscrew,
M10 x 40
(two required)

Back Vertical Bars

Mounting Plate

Washer, 
M10

Vertical Bar

Castor

14 Install the display bracket to the mounting plate
NOTE: The display may need to be removed prior to bracket installation.

AC2947.eps

Display Bracket Placement

Trolley equipped with Printer

Trolley without Printer

Capscrew, M6 x 20
(four required)

Washer

Lockwasher

Display Bracket

Mounting 
Plate

Note bracket 
orientation

AC2946.eps
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NSTALLATIONI
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15 Install the display to the display bracket

AC2948.eps
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Install the spindles to load cells
A	 Install two spindles into each load cell fully seating 

threads.  Use the gauge to set the overall length of 
each assembly.  Adjust length at pads.

CAUTION: Failure to set the overall length of each 
spindle assembly to same length, will result in 
inaccurate measured clamp force results.

B	 Each load cell is marked with a number.  Place the 
load cell assembly on supports, as shown.

C	 Secure extra cord length with provided small 
hook-and-loop ties.

Adjust to gauge length

A

B

1

2

3

4

Spindle

Upper Front

Lower Front

Upper Back

Lower Back

Spindle

Adjust

Adjust Adjust

Load Cell

16
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Secure spindle assemblies and gauge
Using the hook and loop tie kit, perform the following 

for each spindle assembly:

A	 Use the large tie to loosely measure around the 
spindle rod and trolly support, as shown. 

B	 Cut tie with additional length for securing the loop 
side on each side of the buckle and to allow for 
further adjustment.  Cut an additional large tie of 
the same length.

C	 Loop the tie around the ends of each buckle while 
loosely securing the spindle to trolly support on 
each side of the spindle's load cell.

IMPORTANT: Large ties are used to loosely secure 
the spindle assemblies to the trolley.  Tightening the 
ties will result in inaccurate clamp force readings.

Trolly Support

Spindle Rod

A,B

C

17

Secure gauge (optional)
For the gauge:

A	 Determine a location to secure the gauge to 
the trolly that will not interfere with the spindle 
pads contacting the attachment pads.

B	 Cut ties with additional length to secure loop 
side of cable to hook side on each side of the 
buckle.  Cut quantity as required to secure the 
gauge.

C	 Loop the tie around the ends of each buckle 
while securing the gauge to trolly. 

Gauge

Large Tie

Large Tie

18

AC2952.eps
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19

20

If equipped, install printer bracket 
to the mounting plate
A	 Slide the printer bracket onto the mounting 

plate. Align the printer bracket holes with the 
mounting plate holes.

B	 Install hardware.

AC2954.eps

Printer Bracket Placement

Capscrew,
M6 x 20
(two required)

Mounting Plate

Printer Bracket

Washer

Lockwasher

AC D

If equipped, install the printer
A	 Place the printer on printer bracket.

B	 Install hardware to secure printer to the bracket.

C	 Plug the display's printer cable into the printer 
terminal.  Tighten the connector screws.

D	 Plug the printer power supply connector into the 
printer power terminal.

E	 Secure extra cord length with provided hook and 
loop small tie(s).

Printer Back View

Printer

Capscrew, 
M3 x 12 (two)

Lockwasher, 
M3 (two)

Printer 
Bracket
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Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

07/12/2015 08:00AM SCALE #1

Clamp Home

START

ID Number:

Pressure:

ID

07/12/2015 08:00AM SCALE #1
Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK
Lower Front

Zero Print Save New Home

612.0
156.8

25.62 %
154.2

25.20 %

150.8
24.64 %

150.2
24.54 %

PSI

AC2956.eps

Quick System Check
1	 Plug the display's power connector into a 120V power 

source.

2	 Once the display shows the Home screen, press the 
button under "Start" menu option.

3	 Then press the button under "Clamp" menu option.

4	 Once the display shows the Clamp screen, press the 
button on the "Zero" menu option.

5	 Clamp on the trolley's spindle pads. 

6	 The display should show four clamp force values and 
four percentages.  The display is working properly.

7	 Release and OPEN the clamp arms. 

8	 Press the button under the "Home" menu option.

5

2

6

3

4 8



116864736

ETUPS

PRINTUNITS

Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK
Lower Front

Zero Print Save New Home

AC2960.eps

Adjust Spindle Supports
IMPORTANT: Perform this procedure with the aid of a 
Cascade sales representative to determine the optimal 
location of spindle pads for proper clamp force distribution.

1	 Position the trolley between the carton clamp contact 
pad.

1

3

AC2957.eps

3	 From the Clamp screen on the display, press the button 
on the "Zero" menu option.

Clamp 
Screen

2	 If required, adjust the supports to align the spindle 
pads to four locations on each of the carton clamp 
contact pads.  The four locations on the contact pad, 
are determined by the type of products being handled.  
Contact a Cascade sales representative to determine 
optimal pad and spindle positioning.

2

AC2959.eps

Upper Front

Lower Front

Upper Back

Lower Back
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Mark around 
each spindle 
(4 places on 
each pad)

6	 Use a contrasting permanent marking device to outline 
each spindle pad the contact pads.

5	 Refer to the display's four percentages.  Verify that 
the clamp force distribution is within the desired 
percentages and tolerances.

If the tolerance difference is greater than allowable 
tolerance difference, the carton clamp pads require 
shimming.  Refer to installation instructions for the 
carton clamp to shim:

•	 D-Series Carton Clamp Installation Instructions, Part 
No. 670488

•	 G-Series Carton Clamp Installation Instructions, Part 
No. 6871032

PRINTUNITS

Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK
Lower Front

Zero Print Save New Home

612.0
156.8

25.62 %
154.2

25.20 %

150.8
24.64 %

150.2
24.54 %

AC2962.eps

Upper Back, 
Position 2

Upper Front, 
Position 1

Lower Front, 
Position 3

Lower Back, 
Position 4

4	 Clamp on the trolley's spindle pads.

4

6

AC2963.eps

CL2961.eps
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EASURING CLAMP FORCEM

Measure Peak Clamp Force
Peak Force is the maximum measured force applied to the 
spindles.  Also, the display will show the distribution of the 
force applied to each spindle's load cell. 

2	 From the Home Screen, press the button under "Start" 
menu option.

1	 Align the attachment pads with the trolley spindle pads.

8	 Clamp on the spindle pads.  The display will show force 
values and clamp force distribution percentages.

9	 Release the spindle pads.

5	 Verify that the screen shows "PEAK".  Refer to page 17, 
Step 2 to toggle between "PEAK" and "LIVE".

6	 If required, zero the loads cells.

7	 If required, change the units, lbf (pounds-force) or N 
(newtons).  Refer to Display Operation, "Start Screen" for 
details, page 17.

3	 If required, enter the truck identification and pressure 
in the ID screen.  Refer to Display Operation, "Start 
Screen" for details, page 17.

4	 Press the menu selection button under "Clamp" menu 
option.

8
10	 Information shown on the display can be saved and/or 

printed.  Refer to Display Operation, "Start Screen" for 
details, page 17.

Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

07/12/2015 08:00AM SCALE #1

Clamp Home

START

ID Number:

Pressure:

ID

PSI

PRINTUNITS

Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK
Lower Front

Zero Print Save New Home

612.0
156.8

25.62 %
154.2

25.20 %

150.8
24.64 %

150.2
24.54 %

AC2964.eps

2

3
4

5
6 7

If required

If required
If required

The following section covers the general procedure for measuring the clamp force of a carton clamp attachment. For 
further details on a specific step of the procedure, refer to Display Configuration section, page 15-20.  There are two 
methods of measuring, peak clamp force (procedure below) or live clamp force (procedure on the following page).  Peak 
force is the highest clamp force measured. While in peak mode, the percentage distribution will also show.  Live force is the 
real time clamp force measured. 

AC2965.eps
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Measure Live Clamp Force
Live clamp force is the real time (current moment in time) 
measured force applied to the spindles.

IMPORTANT: When measuring clamp force in "LIVE" 
mode, the data can not be saved or printed.

4	 Verify that the screen shows "LIVE".  Refer to page 17, 
Step 2 to toggle between "PEAK" and "LIVE".

5	 If required, zero the loads cells.

6	 If required, change the units, lbf (pounds-force) or N 
(newtons).  Refer to Display Operation, "Start Screen" for 
details, page 17.

7	 Clamp on the spindle pads.  The display will show force 
values.  Clamp force for each spindle and clamp force 
will show on the display.

8	 Release the spindle pads.

3	 Press the button under "Clamp" menu option.

2

3

4
5 6

If required

If required

7

2	 From the Home Screen, press the button under "Start" 
menu option.

1	 Align the attachment pads with the trolley spindle pads.

AC2965.eps

Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

PRINTUNITS

Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

LIVE
Lower Front

Zero Print Save New Home

510.2
129.1128.6

125.8126.7

07/12/2015 08:00AM SCALE #1

Clamp Home

START

ID Number:

Pressure:

ID

PSI

AC2966.eps
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ISPLAY CONFIGURATIOND

Accessing the Home Screen
1	 Plug the power cord on the display into a 120V power 

source.

NOTE: If equipped with printer, plug the printer's power 
cord into a power source.

2	 Wait for the screen to load to the Home screen.

3	 The Home screen will show.  Press a menu option 
button:

•	 Start (A) – Goes to the Start screen. This screen is for 
obtaining clamp force values.  Refer to page 17.

OR

•	 Data (B) – Goes to the Data screen. This screen 
allows the user to view data stored or download 
stored data.  Refer to page 18.

OR

•	 Setup (C) – Goes to the Setup screen.  This screen 
has options for changing data/time, create/change 
password, change the screen's contrast and adjust 
the threshold force value.  Refer to page 19.

NOTE: Refer to the following page for the display's 
layout.

Display Buttons
The following is the basic layout of the display for reference:

PRINTUNITS

Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

AC2968.eps

A B C

Home Screen

2

3

A Entry Text Box

B Display Screen

C
Left and right arrows toggle between PEAK and 
LIVE (Clamp Screen)

D Accesses Character Menu Box

E Enter button – Accepts a value

F Menu Options

G Zeros clamp force (Clamp Screen)

H Toggle between units – Imperial and Metric

I NOTE: Buttons are not functional

J Buttons for selecting menu options

K Decimal button

L Numeric buttons

M CLR button – backspace when changing a value

PRINTUNITS

07/12/2015 SCALE #108:00AM

AC2967.eps

A B C D E

F G H I J K L M
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PRINTUNITS

Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

AC2969.eps

ID

Clamp

Zero

Page Up

Print

Page Down

Save

Print

New

Delete

Home

Home

Home

USB

View

Home

Date/Time

Password

Contrast

Threshold
Force

Home

Enter ID 
Number

Returns to
Home Screen

Returns to
Home Screen

Returns to
Home Screen

Choose:
Save Configuration 
(*.920) Enter Time

Enter Date

Create/Change
Password for
Setup Screen

Change Display's 
Contrast

Enter Threshold 
Force

Save All Databases 
(*.db)

Drive

No Device

Enter Delivered 
Truck Pressure

Start

Home Screen

Setup
Data

Navigation Tree
From the home screen (shown), 
pressing one of the buttons, will go 
to following screens:

NOTE: For detailed information, 
refer to the following pages.
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ISPLAY CONFIGURATIOND

PRINTUNITS

START

ID Number:

Pressure:

Clamp HomeID

PSI

PRINTUNITS

07/12/2015 08:00AM SCALE #1

START

ID Number:

Pressure:

Cancel EndHome

ENTER TRUCK ID
Truck123=>

PRINTUNITS

07/12/2015 08:00AM SCALE #1
Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK0

0

0

0

Lower Front

Zero Print Save New Home

PSI

AC2970.eps1
2

3

A

A,B

A,B

A

B C D E F

Accesses the 
Character 
Menu Box

Accepts 
the value

Toggle 
"Peak"/"Live"

Moves the 
cursor to 
the far left

Moves the 
cursor to 
the far right

Clears the 
highlighted 
character in 
the text entry 
box

Cancels the 
action and 
returns the 
main menu

Start Screen
After the "Start" menu option button is pressed, the Start 
screen will show.  From the Start screen:

1	 When the "ID" menu option button is pressed, the screen 
goes to the ID screen. The screen will prompt:

A	Enter the truck identification  To enter the truck 
identification, use the numeric buttons and character 
menu box.  To accept the truck identification, press 
the "enter" button.

NOTE: Refer to Appendix, "Letters and Special 
Characters", page 26 for more detail. 

B	Enter the pressure value. Use the numeric buttons to 
enter a value. To accept the value, press the "enter" 
button.

C	The screen will then return to the Start screen.

2	 When the "Clamp" menu option button is pressed, the 
screen goes to the Clamp screen. The following options 
are available:

•	 Use the left and right arrow button to toggle between 
"Peak" and "Live". (A)

•	 "Zero" menu option button (B)– Zeroes residual or 
unladen force values appearing on the display prior 
to clamping.

•	 "Print" menu option button (C)– If equipped with the 
printer, the data will print out.  The ticket will list the 
truck identification, pressure, peak clamp forces for 
each load cell, total clamp force, date and time.

2	  (continued)

•	 "Save" menu option button (D) – The peak value is 
saved to the display's internal memory.

•	 "New" menu option button (E) –  Returns to the Start 
screen.

•	 "Home" menu option button (F) –  Returns to the 
Home screen.

3	 When the "Home" menu option button is pressed, the 
screen returns to the Home screen.

Start Screen

ID Screen Clamp Screen
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07/12/2015 08:00AM SCALE #1

View Home

DATA - USB

USB

Insert USB Drive and Press USB Key to Download
Press View to View Print and Delete Records

07/12/2015 08:00AM SCALE #1

Print DeletePage DownPage Up

Col PSI UB UF LB LFID Date/Time
1 T1 1350 0 0 0

Totals

2
3
4
5
6

13-09-19 07:58:20 AM
T1 1365 0 0 013-09-18 05:00:58 PM
T1 1507 0 0 013-09-18 04:50:32 PM
T1 1421 0 0 013-09-18 04:10:54 PM
T1 2032 -1 2 113-09-18 03:15:18 PM
T1

600
600

1000
700

1500
600 1275 -1 0 013-09-18 02:42:10 PM

3566 3180 3326 361613-09-19 07:59:58 AM

Home

07/12/2015 08:00AM SCALE #1

DATA - USB

Insert USB Drive and Press USB Key to Download
Press View to View Print and Delete RecordsSave Configuration (*.920)

Save All Databases (*.db)
Drive

No Device

AC2971.eps

1 2

3

AA

AB

B C D E
Selected position 
is highlighted

Data Screen
All clamp force data is stored in a database table format 
and can be downloaded to a USB flash drive.  Data can 
also be viewed on the display screen.

IMPORTANT: Prior to pressing the "USB" menu option 
button, install a USB flash drive into the display's USB port.

After the "Data" menu option button is pressed, the Data 
screen will show.  From the Data screen:

1	 When the "USB" menu option button is pressed, the 
screen goes to the USB screen. The screen will prompt:

NOTE: If a USB flash drive is not installed, the text entry 
box will show, "No Device available".

A	Use the arrow buttons to highlight "Save All 
Databases (*.db)". 

B	Press the "enter" button to save the database files to 
the USB flash drive.

2	 When the "View" menu option button is pressed, the 
screen goes to the View screen. The following options 
are available:

•	 "Page Up" menu option button (A) – The previous 
table page will show.

•	 "Page Down" menu option button (B) –  The next 
table page will show.

2	 (continued)

•	 "Print" menu option button (C) –  Allows for one row 
to be printed.  The screen will prompt for the row 
number.  Press the "enter" button to accept entered 
row number and create the printout.

•	 "Delete" menu option button (D) – Deletes all data 
stored in the table.

•	 "Home" menu option button (E) –  Returns to the 
Home screen.

3	 When the "Home" menu option button is pressed, the 
screen returns to the Home screen.

USB Screen View Screen

Data Screen
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PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Contrast HomeDate/Time Setup
Password

Threshold
Force

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Cancel EndHome

EnterTime
HHMMSS

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Cancel EndHome

ENTER NEW PASSWORD
=>

AC2972.eps

Setup Screen
The Setup Screen contains five menu options.  Four options 
change the following settings: Date and time, password 
enabled Setup screen, screen contrast and threshold force.  
The fifth option returns to the Home screen.

After the "Setup" menu option button is pressed, the Setup 
screen will show. From the Setup screen:

1	 When the "Date/Time" menu option button is pressed, 
the following steps will show in the text entry box:

A	Use the numeric buttons to change the time, in 
HHMMSS format.

B	To accept the time value, press the "enter" button.

C	Use the numeric buttons to change the date, in 
MMDDYY format.

D	To accept the time value, press the "enter" button.

E	The screen returns to the main Setup screen.
2	 When the "Password" menu option button is pressed, 

the  following steps will show in the text entry box:

A	To create/change the password.  Use the numeric 
buttons and character menu box.  

NOTE: Refer to Appendix, "Letters and Special 
Characters", page 26 for more detail.

B	To accept the new/changed password, press the 
"enter" button.

C	The screen returns to the main Setup screen.

1 2

B,D

A,C
A

A

B
Accesses the 
Character 
Menu Box

Accepts 
the value

Moves the 
cursor to 
the far left

Moves the 
cursor to 
the far left

Text Entry Box Text Entry Box

Moves the 
cursor to 
the far right

Moves the 
cursor to 
the far right

Clears the 
highlighted 
character in 
the text entry 
box

Clears the 
highlighted 
character in 
the text entry 
box

Cancels the 
action and 
returns to 
main menu

Cancels the 
action and 
returns to 
main menu

Setup Screen - Change Date/Time Setup Screen - Change Password

Setup Screen

Button Menu Options continued on the next page
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PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Contrast HomeDate/Time Setup
Password

Threshold
Force

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Cancel EndHome

Contrast (0-127)=>

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
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Setup Screen (continued)
After the "Setup" menu option button is pressed, the Setup 
screen will show. From the Setup screen:

3	 When the "Contrast" menu option button is pressed, the 
screen will prompt:

A	Use the numeric buttons to enter a value within the 
range of 0 to 127.

B	To accept the contrast value, press the "enter" button.

C	The screen returns to the main Setup screen.

4	 When the "Threshold Force" menu option button is 
pressed, the screen will prompt:

A	Use the numeric buttons to change the Threshold 
Force value.  This is the minimal value that will 
produce a response when a force is being applied to 
the spindles.  The default value is set to 10.

B	To accept the threshold force value, press the "enter" 
button.

C	The screen returns to the main Setup screen.

5	 When the "Home" menu option button is pressed, the 
screen returns to the Home screen.

3 4

5

B B

Setup Screen - Change Contrast Setup Screen - Change Threshold Force

Setup Screen

Moves the 
cursor to 
the far left

Moves the 
cursor to 
the far left

Text Entry Box Text Entry Box

Moves the 
cursor to 
the far right

Moves the 
cursor to 
the far right

Clears the 
highlighted 
character in 
the text entry 
box

Clears the 
highlighted 
character in 
the text entry 
box

Cancels the 
action and 
returns the 
main menu

Cancels the 
action and 
returns the 
main menu

AA
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The original file saved to the USB flash drive is a database 
file (file extension: ".DB").  If a database program is not 
available to view, the file can be opened by performing the 
following procedure.

NOTE: The following procedure uses Excel 2010.  Other 
similar software may have a different procedure than the 
one shown below.

1	 Plug the USB flash drive into a computer USB port. 
Navigate to the root directory (top level) of the USB flash 
drive.

2	 Locate the file called "TRANSACT.DB".  Create a copy 
of the file on the USB flash drive or to a specified file 
location.

3	 Change the copied file's file extension from "DB" to "txt".  
Example: TRANSACT.DB becomes TRANSACT.txt

12

5

67 8

4	 Launch Excel software.

5	 In the Excel menu, choose "File" and then "Open".

AC2737.eps

6	 In the "Open" dialog box, change the filter to "All Files 
(*.*)".

7	 Choose the file "TRANSACT.txt" from the file location the 
file was copied to (Step 2).

8	 Click the "Open" button.

AC2975.eps
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	10	 Choose the "Finish" button.  The file will open.

	11	 Save the file as an Excel document (file type ".xlsx").

	12	 The file is ready to review.

	 9	 A "Text Important Wizard" dialog box will 
appear.  Verify that the following options 
are selected:

A	Original Data Type: Delimited

B	Delimiters: check "Other", add "|" in 
the text box next to the check box.

NOTE: The character "|" (vertical 
bar), can be found on the keyboard 
above the backslash (reverse 
solidus).  To add the character press 
the "shift" key + "\" key.

C	Column Data Format: "General"

A

B

C

9

10

12A Upper Back (Position 1)

B Upper Front (Position 2)

C Lower Back (Position 3)

D Lower Front (Position 4)

E Total

F Date and Time

G Pressure Type

H Truck ID

A D F H

B C E G

AC2978.eps
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ARTSP
4-Point Force Distribution Tester
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REF QTY PART NO. DESCRIPTION

6841756 4-Point Force Distribution Tester ◆
6859239 Printer and Mounting Group ▲

1 1 6841757 Trolly Assembly l
2 1 6841983 Display ▼
3 4 6854155 Spindle/Pad Assembly
4 1 6842112 Gauge
5 1 6841986 Display Bracket
6 ■ 6842210 Small Tie Set, Hook and Loop A

u	� Includes items 1–10.
▲	� Includes items 8–14.
l	� See Trolly Assembly page for parts breakdown.
▼	� Includes items 5 and 6.
■	� Quantity as required.

REF QTY PART NO. DESCRIPTION

7 ■ 6868083 Large Tie, Hook and Loop Kit B
8 ■ 763169 Capscrew, M6 x 20
9 ■ 206323 Lockwasher, M6
10 ■ 202346 Washer, M6
11 1 6842181 Printer
12 1 6842218 Printer Bracket
13 2 6406230 Washer, M3
14 2 680215 Capscrew, M3 x 12

A	Each set contains 10 small ties.
B	� Each kit contains 15 ft. (4.5 m) of hook and loop tie and 

10 buckles.  The kit makes 8 to 10 ties.

NOTE: Install paper in the 
direction as shown.

Printer Paper Replacement
Use Epson Thermal Paper 
Manufacturer's Part No.: NTP080-80
Paper Width: 3.15 in. (80 mm)
Maximum Diameter: 3.27 in. (83 mm)
Spool Diameter: 0.47 in. (12 mm) ID
	 0.71 in. (18 mm) OD
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ARTSP
Trolley Assembly
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ARTSP
Trolley Assembly

REF QTY PART NO. DESCRIPTION

6841757 Trolley Assembly
1 4 6524444 Spacer Bar
2 4 6846552 Back Support
3 4 6841206 Vertical Bar
4 4 6524033 Castor Wheel
5 8 6868629 Pin
6 10 206322 Washer, M10
7 8 684594 Capscrew, M10 x 20
8 16 787373 Capscrew, M8 x 25
9 16 787384 Washer, M8
10 16 767414 Nut, M8
11 4 6524473 Guide
12 2 6841809 Sliding Support with Spacer Bar
13 2 6524355 Sliding Support 
14 2 6846616 Front Lower Support
15 2 6846617 Front Upper Support
16 1 6841914 Mounting Plate
17 2 787374 Capscrew, M10 x 40
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PPENDIXA
Refer to the following when text, special characters or 
numbers are required. 

1	 When text or special character(s) is required, press the 
"Up" arrow button to open the Character Menu Box.

2	 For each character position:

•	 Press a numeric button 

OR

•	 Use the arrow buttons to move the cursor to highlight 
a letter or special character and then press the 
"enter" button.

3	 When finished with entering numbers, letters and/or 
special characters, use the arrow buttons to move the 
cursor into the text entry box.

NOTE: Always verify that the cursor is not in the 
character menu box.  Pressing the "enter" button will 
add the highlighted character to the text entry box 
rather then accepting the entered text.

4	 Press the "enter" button to accept the value.

Indicates 
character 
position

Press the "UP" arrow to open 
the Character Menu Box

Moves the indicator 
to the first character 
in the text entry box

Moves the indicator 
to the last character 
in the text entry box

Cancels the 
function

Text Entry Box

Character 
Menu Box

Press the "enter" button 
to accept the text/special 
character.  The character 
will be added to the text 
entry box.

Use arrow buttons to highlight 
over a text or special character

Clears the 
indicated 
character

Press a numeric 
button to add a 
number to the text 
entry box

Cursor

Letters and Special Characters

PRINTUNITS

07/12/2015 SCALE #108:00AM

Home Cancel
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End
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Do you have questions you need 
answered right now?  Call your nearest Cascade Service Department.
Visit us online at www.cascorp.com

AMERICAS
Cascade Corporation
U.S. Headquarters
2201 NE 201st
Fairview, OR 97024-9718
Tel: 800-CASCADE (227-2233)
Fax: 888-329-8207

Cascade Canada Inc.
5570 Timberlea Blvd.
Mississauga, Ontario
Canada L4W-4M6
Tel: 905-629-7777
Fax: 905-629-7785

Cascade do Brasil
Praça Salvador Rosa,
131/141-Jordanópolis, 
São Bernardo do Campo - SP
CEP 09891-430
Tel: 55-13-2105-8800
Fax: 55-13-2105-8899

EUROPE-AFRICA
Cascade Italia S.R.L.
European Headquarters
Via Dell’Artigianato 1
37030 Vago di Lavagno (VR) 
Italy
Tel: 39-045-8989111
Fax: 39-045-8989160

Cascade (Africa) Pty. Ltd.
PO Box 625, Isando 1600
60A Steel Road
Sparton, Kempton Park
South Africa
Tel: 27-11-975-9240
Fax: 27-11-394-1147

ASIA-PACIFIC
Cascade Japan Ltd.
2-23, 2-Chome,
Kukuchi Nishimachi
Amagasaki, Hyogo 
Japan, 661-0978
Tel: 81-6-6420-9771
Fax: 81-6-6420-9777

Cascade Korea
121B 9L Namdong Ind. 
Complex, 691-8 Gojan-Dong
Namdong-Ku
Inchon, Korea
Tel:  +82-32-821-2051
Fax: +82-32-821-2055

Cascade-Xiamen
No. 668 Yangguang Rd.	
Xinyang Industrial Zone
Haicang, Xiamen City
Fujian Province
P.R. China 361026
Tel:  86-592-651-2500
Fax: 86-592-651-2571

Cascade India Material 
Handling Private Limited
No 34, Global Trade Centre 
1/1 Rambaugh Colony
Lal Bahadur Shastri Road, 
Navi Peth, Pune 411 030
(Maharashtra) India
Phone: +91 020 2432 5490
Fax: +91 020 2433 0881

Cascade Australia Pty. Ltd.
1445 Ipswich Road
Rocklea, QLD 4107
Australia
Tel: 1-800-227-223
Fax: +61 7 3373-7333

Cascade New Zealand
15 Ra Ora Drive
East Tamaki, Auckland
New Zealand
Tel: +64-9-273-9136
Fax: +64-9-273-9137

Sunstream Industries
Pte. Ltd.
18 Tuas South Street 5
Singapore 637796
Tel:  +65-6795-7555
Fax: +65-6863-1368
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